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GEOGRAPHICAL INFORMATION SYSTEMS LAB 

 

Course Code: A3132                                                                                                    L T P C 
                                                                                                                                      0 0 2 1 
 

LIST OF EXPERIMENTS: 
 
1. Familiarization with GIS Software, Data Input 

2. Geo Referencing and Projections 

3. Digitization of Map/ Toposheet 

4. Creation of Thematic Maps 

5. Base Map Preparation 

6. Data Conversion – Vector to Raster, Raster to Vector 

7. Adding Attribute Data – Querying On Attribute Data 

8. Vector Analysis 

9. Raster Analysis 

10. Map Composition 

11. Developing Digital Elevation Model 

12. Simple Applications of GIS in Water Resources Engineering & Transportation Engineering 

 
 

GIS SOFTWARE: 
 
Arc GIS 10.3 
 
TEXT BOOKS: 
 
1. Concept and Techniques of GIS by C.P.L.O. Albert, K.W. Yong, Printice Hall Publishers 
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EXPERIMENT – 1 

 
 FAMILIARIZATION WITH GIS SOFTWARE, DATA INPUT

 

 
AIM: To familiarize with the main modules of ESRI's ArcGIS software and Data Input. 
 

APPARATUS: Arc GIS Software, Survey of India Topo Sheet. 
 
THEORY & PRINCIPLE: 
 
ArcGIS Overview: 
 
The geographic information system software package ArcGIS was developed by the 

Environmental Systems Research Institute (ESRI). ArcGIS is designed to create, develop, and 

interact with new and existing geographic data. It’s designed to be a complete and 

integrated system for geographic data processing.  

The desktop form of ArcGIS is available with three levels of functionality. The most basic 

level is called ArcView, which allows for many map making, visualization and map analysis 

capabilities. For creating and editing spatial data that go into these analyses, ArcEditor adds 

capabilities on top of ArcView. Finally, more advanced visualization and analysis tools are 

available at the ArcInfo level. At all levels, users interact with Desktop ArcGIS through three 

interface components: ArcMap, ArcCatalog, and ArcToolbox.  

ArcMap is used to perform map and data-based tasks. These include geographic and 

attribute data creation, editing, data viewing and querying, and map production.  

ArcCatalog is designed to browse, organize, and document geographic data in a Windows 

Explorer-like fashion. Operations such as previewing, copying, moving, renaming, or deleting 

can be performed within this module.  

ArcToolbox is the data management and geo-processing module embedded within ArcMap 

and ArcCatalog. Task wizards have been created for the most commonly performed geo-

processing operations. Some of the functionality includes: importing and exporting, 

overlays, buffering, and statistical calculations. 

Data Input Techniques: 

The choice of data input method is governed largely by the application, the available 

budget, and the type and the complexity of data being input. 

There are at least four basic procedures for inputting spatial data into a GIS. These are: 

1. Manual digitizing; 

2. Automatic scanning; 

3. Entry of coordinates using coordinate geometry; and the 

4. Conversion of existing digital data. 

 

PROCEDURE: 

1. Exploring the ArcGIS Help System 

2. Exploring ArcMap tools 
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3. Starting with ArcCatalog or ArcMap and connecting to data inputs 

4. Finding GIS data on the Internet  

5. Downloading data from the web 

6. Displaying data in ArcMap  

 

RESULTS: 

 

1. Manual Tracing of Base Map, Drainage Map, Contour map 

2. Scanned Survey of India Topo Sheet  
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EXPERIMENT – 2 

 GEOREFERENCING AND PROJECTIONS 

AIM: To assign spatial reference or georeference and projection to given Topo sheet or 

map 

APPARATUS: Arc GIS Software, Scanned Survey of India Topo Sheet 

THEORY & PRINCIPLE: 

Raster data is commonly obtained by scanning maps or collecting aerial photographs and 

satellite images. Scanned map datasets don't normally contain spatial reference 

information. With aerial photography and satellite imagery, sometimes the location 

information delivered with them is inadequate, and the data does not align properly with 

other data you have. Thus, to use some raster datasets in conjunction with other spatial 

data, need to align or georeference those to a map coordinate system. A map coordinate 

system is defined using a map projection (a method by which the curved surface of the 

earth is portrayed on a flat surface). 

Georeferencing 

It is a process of locating an entity in real world coordinates. It aligns geographic data to a 

known coordinate system representing earth defined through projection systems so it can 

be viewed, queried, and analyzed with other geographic data. 

To georeference a geographic data, the positions of known points, called control points, are 

determined. The Ground Control Points (GCPs) are defined as the points with known 

geographical location, whose positions on map correspond to their positions on earth. GCPs 

are collected from fixed objects and are marked on the data to be georeferenced that define 

where the data is on earth. The whole data adjusts itself according to these GCPs. At least 

three control points are required for georeferencing a data.  Additional control points help 

increasing the accuracy. Once the data is georeferenced, each point has a coordinate 

associated to it which means the location of any object in the data (map) can now be 

determined 

 

Figure: Georeferencing an image 
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Map Projection 

Map projection is a mathematical expression using which the three-dimensional surface of 
earth is represented in a two dimensional plane.  

Commonly used projection systems: 

Property Developable 
surface 

Aspect Projections Extent of use 

  

  

  

  

  

  

Conformal 

(True shape) 

  

  

  

Cylinder 

Normal Mercator Equatorial regions (east-west 
extent) 

Transverse UTM (Universal 
Transverse 
Mercator) 

Whole world except polar 
areas 

Oblique Rosenmund 
Oblique Mercator 

Small regions, oblique & east 
- west extent 

Cone Normal Lambert 
Conformal Conic 

Small regions, oblique & east 
- west extent (1 or 2 standard 
parallels) 

Plane Any Stereographic Small regions upto the 
hemisphere 

Polar UPS (Universal 
Polar 
Stereographic) 

Polar regions 

  

  

  

Homolographic 

(Equal area) 

Cylinder Normal Lambert Equal 
Area 

Equatorial areas (east-west 
extent) 

Cone Normal Albers Equal Area Smaller regions & continents 
with east-west extent 

  

Plane 

Any Lambert 
Azimuthal Equal 
Area 

Smaller regions about same 
north-south , east-west 
extent 

Equatorial Hammer-Aitoff World 

  

  

  

  

Equidistant 

Cylinder Normal Plate Caree World 

  Transverse Cassini Soldner Locally used for large scale 
mapping 

Cone Normal Equidistant Conic Smaller regions & continents 
with (1 or 2 standard 
parallels) east-west extent 

Plane Any Azimuthal 
Equidistant 

Smaller regions about same 
north-south , east-west 
extent 

A geographic coordinate system (GCS) uses a three-dimensional spherical surface to define 

locations on the earth. A GCS is often incorrectly called a datum, but a datum is only one 

part of a GCS. A GCS includes an angular unit of measure, a prime meridian, and a datum 

(based on a spheroid).A point is referenced by its longitude and latitude values. Longitude 
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and latitude are angles measured from the earth's center to a point on the earth's surface. 

The angles often are measured in degrees (or in grads). 

A projected coordinate system is defined on a flat, two-dimensional surface. Unlike a 

geographic coordinate system, a projected coordinate system has constant lengths, angles, 

and areas across the two dimensions. A projected coordinate system is always based on a 

geographic coordinate system that is based on a sphere or spheroid. 

In a projected coordinate system, locations are identified by x,y coordinates on a grid, with 

the origin at the center of the grid. Each position has two values that reference it to that 

central location. One specifies its horizontal position and the other its vertical position. The 

two values are called the x-coordinate and y-coordinate 

 

PROCEDURE: 

Georeferencing a Topo sheet/Map 

1. Open ArcMap with a new, empty map, and add the raster data to be georeferenced 

to the ArcMap session. 

2. Open View > Data Frame Properties > Coordinate System tab > Predefined, and 

browse to the geographic Coordinate System\WORLD\WGS 1984 of the output 

coordinates you will use in this process. 

3. Add the Georeferencing toolbar to ArcMap. 

4. Zoom in to the first point on the raster image that will be used as a control point, 

then click the Add Control Points tool. 

5. Place the cursor over the first control point in the raster and right-click. 

6. Select Input X and Y. 

7. Enter the known output coordinates for this control point and click OK. 

8. Repeat the same procedure to enter all four points of the map for the desired 

transformation order. 

9. Click View Link Table to evaluate the transformation and save GCPs.  

10. Click the Georeferencing menu and select the rectify option to save the 

transformation information with the raster in ‘IMAGINE image’ format. 

 
Re-projecting maps 
 

1. ArcToolbox → Data Management → Projections and Transformations → Raster → 

Project Raster 

2. Data Frame Properties → Coordinate System → projected coordinate system and 

browse to UTM\ WGS 1984\ Northern Hemisphere\WGS_1984_UTM_Zone_44N. 

3. Click Apply and ok to save the Re-Projection. 
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RESULTS: 
 

1. The given Toposheet is georeferenced to minimum residual error and the resulting 
.img file is also checked for accuracy. 

2. The given georeferenced Toposheet is re-projected to the local/regional coordinates. 
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EXPERIMENT – 3 

DIGITIZATION OF MAP/ TOPOSHEET 
 
AIM: To digitize (Vectorization) a Map/Toposheet using ArcGIS. 
 
APPARATUS: Arc GIS Software, Georeferenced and projected Survey of India Topo Sheet. 
 

THEORY & PRINCIPLE: 
 

Digitization is the process of converting analog data into digital data sets. In GIS context 

digitization refers to creating vector datasets viz., point, line or polygon from raster 

datasets. It is a way of tracing/recording geographic features in vector format from 

georeferenced images or maps. With the help of digitization we can create different set of 

layers Viz. Rivers, roads, schools, ward boundaries and building blocks from a single map; 

this process is known as Vectorization. Vector data is easy to edit, update and is more 

accurate as compared to raster data. Vector data is more efficient for GIS analysis. Due to 

these reasons Vectorization is the first step in many GIS projects.  

 

Vector data is mainly of three types  

 

- Point: It consists of single points having (X, Y) coordinates, for example lamp posts, bus 

stops and postbox positions etc.  

- Line: It consists a series of (X, Y) coordinates in a sequence (from start node to end node 

with a number of vertices joining these two nodes). For example roads, power lines, 

ward boundaries and contours etc. 

 - Polygon: It is a series of (X, Y) coordinates in a sequence closing a figure where first and 

last points are the same. For example lakes, building blocks, village blocks, ward areas 

and forests etc. 

 

Shapefile  
 
A shapefile is an Esri vector data storage format for storing the location, shape, and 

attributes of geographic features. It is stored as a set of related files and contains one 

feature class. Shapefiles often contain large features with a lot of associated data and 

historically have been used in GIS desktop applications such as ArcMap.  

 

PROCEDURE: 
 
Creating a new shapefile 

 
1. Open ArcCatalog 

2. Navigate to project folder 

3. From the menu, click File>New>Shapefile 
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4. Give shapefile a name and select geometry (point, line or polygon), based on 

what type of features are trying to draw. 

5. Use the Edit button to select the projected coordinate system 

WGS_1984_UTM_Zone_44N. 

6. Click on ok to create shapefile. 

7. Use the same projection for all map layers in a project in order to preserve 

accuracy. 

Editing Shapefile 
 

1. Add shapefile to ArcMap project 

2. Open the Attribute Table of shapefile 

3. Using the Attribute Table Options button, use the Add Field button to add fields you 

want to keep track of.   

4. Optional: Set the symbology of your fields now.  This will save time later when 

creating features. 

 

Digitization 

1. Open the snapping toolbar Via Customize Toolbars>snapping  

2. Make sure snapping is turned on and that all types are active. 

3. Editor -> start editing. Select which layer to edit (your new shapefile point, line or 

polygon). Select the task to perform (Create New Feature). 

4. Select the editing pencil tool and click on, along, or around the features in a 

georeferenced and projected map you want to digitize or vectorize. You can zoom 

and pan to make this easier. 

5. When finished drawing, right click and select Finish Sketch. 

6. To edit the attribute table for the feature you just created click the Attributes icon 

on the Editor Toolbar. 

7. All the editable fields for the feature you just created will appear.  This way you can 

label your features as you create them. 

8. When you’re done creating features click on the Editor button on the Editor toolbar 

and select Save Edits, and then Stop Editing. 

 
Note: 

1. The symbology of the shapefile you just created can be manipulated. 

2. Modifications to an existing layer can be made using the Modify Feature task, rather 

than Create New Feature. Using the Edit Tool individual vertices can be moved, 

added or deleted. Right-click the vertices with the edit tool to see all options 

available. 

3. You can only edit the values in the Attribute Table of your shapefile while in Editing 

is turned on 

4. However, you cannot create new fields in the Attribute Table while Editing is turned 

on.  Create fields before starting an editing session. 
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RESULTS: 

The different vector layers created using the given Toposheet are: 

1. Point features/layers:  

2. Line features/layers: 

3. polygon features/layers: 
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EXPERIMENT – 4 

CREATION OF THEMATIC MAPS 

AIM: To create thematic maps of given Toposheet using Arc GIS 
 

APPARATUS: Arc GIS Software, Georeferenced and projected Survey of India Toposheet. 
 

 

THEORY & PRINCIPLE: 
 

Thematic Map 
 

A "thematic map" is a type of map especially designed to show a particular theme 

connected with a specific geographic area. These maps "can portray physical, social, 

political, cultural, economic, sociological, agricultural, or any other aspects of a city, state, 

region, nation, or continent". 

Thematic maps maps are further divided into two types, 

 

a. Choropleth map 

a map which uses differences in shading, colouring, or the placing of symbols within 

predefined areas to indicate the average values of a particular quantity in those areas. 

 

b. Isopleths map 

An isopleth map generalizes and simplifies data with a continuous distribution. It shows the 

data as a third dimension on a map, thus isopleth maps are more common for mapping 

surface elevations, amounts of precipitation, atmospheric pressure, and numerous other 

measurements that can be viewed statistically as a third dimension. 

 

Types of Data  

 

To create a thematic map using ArcMap you will need two kinds of data: 

  

1. Spatial data: Displaying boundaries, roads, or some other geographic feature(s). Spatial 

data is georeferenced in a real world coordinate system and may contain limited attribute 

information associated with its features. Discrete geographic objects (as opposed to 

continuously varying variables, like elevation) are generally represented by one or more of 

three geometrical forms in a GIS:  

• Points are used for showing occurrence or relative locations (rather than size or 

dimension), of features such as trees and fire hydrants, or (from a large scale perspective) 

buildings or cities.  

• Lines, composed of connected points or nodes, can represent routes, pathways or 

boundaries, or for uses not requiring detailed polygons, such as rivers or roads.  

• Polygons consist of a series of nodes and lines enclosing an area, representing things such 

as state boundaries, lakes, and tracts of land.  
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2. Attribute data: Descriptive information about a set of features and the information 

needed to create the “theme” in a thematic map. It can be a statistical data set collected 

through surveys, Census data, or any other information that describes the features 

represented in your spatial data set. 

 

PROCEDURE: 
 

1. Open new ArcMap and change the data frame properties to 

WGS_1984_UTM_Zone_44N.  

2. Add the Georeferenced and projected Survey of India Toposheet which we have to 

digitize for thematic maps creation using Add icon. 

3. Create point, line and polygon shape files using arc catalog 

4. Editor -> start editing. Select which layer to edit (your new shapefile point, line or 

polygon). Select the task to perform (Create New Feature). 

5. Select the editing pencil tool and click on, along, or around the features in a 

georeferenced and projected map you want to digitize and create point, line and 

polygon themes. 

6. When finished drawing, right click and select Finish Sketch,  

7. To edit the attribute table for the feature you just created click the Attributes icon 

on the   Editor Toolbar. 

8. All the editable fields for the feature you just created will appear.  This way you can 

label your features as you create them. 

9. Use the 'symbology' tab of the layer properties to modify the characteristics of the 

theme 

10. When you’re done creating features click on the Editor button on the Editor toolbar 

and select Save Edits, and then Stop Editing. 

 
Note: 
 
Application of symbology to thematic map: 
Layer properties-> symbology 
E.g. 

1. Choropleth thematic map: Village theme, waterbodies theme, settlements theme 
etc. 

 Legend Type: Graduated Color 
 Classification Field: Population/village name 
 Normalize by: <None> 
 Color Ramps: multicolor 

2. Isopleths map: Contour, Drainage themes etc 

 Categories: Unique Value 
 Values Field: drainage/contour ID 
 Color Schemes: (don't change) 
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 Then click Add All Values  

RESULT:  
 
Thematic maps created in a given Toposheet are: 
Choropleth thematic maps: Village theme, water bodies theme, settlements theme etc. 
Isopleth thematic maps: Contour, Drainage themes etc. 
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EXPERIMENT – 5 

BASE MAP PREPARATION 
 
AIM: To create basemap of given Toposheet using Arc GIS 
 
APPARATUS: Arc GIS Software, Georeferenced and projected Survey of India Toposheet. 

 
THEORY & PRINCIPLE: 
 
A basemap is used for locational reference and provides a framework on which users 

overlay operational or thematic layers, perform tasks, and visualize geographic information. 

The basemap serves as a foundation for all subsequent operations and mapping. Basemaps 

provide the context and a framework for working with information geographically. 

Basemaps tend to be relatively static and, in a typical setting, are updated on an infrequent 

basis. In addition; basemaps are often designed to be used at multiple map scales. The 

basemap portrays appropriate content at each range of map scales. 

Characteristics of GIS basemaps  
 
In many ArcMap applications, users have basemaps onto which operational information, 

observations, and derived information from analytic models are displayed and used. For 

example:  

 Orthoimagery is often used as a general base onto which operational information is 

overlaid.  

 In utilities applications, a land base of parcel boundaries, buildings, and other built 

features are often used as a basemap.  

 Many city maps use the street network as a basemap on top of which layers such as 

incidents and events are displayed.  

PROCEDURE: 
 

1. Open new ArcMap and change the data frame properties to 

WGS_1984_UTM_Zone_44N.  

2. Add the Georeferenced and projected Survey of India Toposheet which we have to 

digitize for thematic layers creation using Add icon. 

3. Create point, line and polygon shape files using arc catalog. 

4. Editor -> start editing. Select which layer to edit (your new shapefile point, line or 

polygon). Select the task to perform (Create New Feature). 

5. Select the editing pencil tool and click on, along, or around the features in a 

georeferenced and projected map you want to digitize and create point, line and 

polygon layers. 

6. When finished drawing, right click and select Finish Sketch,  
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7. To edit the attribute table for the feature you just created click the Attributes icon 

on the   Editor Toolbar. 

8. All the editable fields for the feature you just created will appear.  This way you can 

label your features as you create them. 

9. Use the 'symbology' tab of the layer properties to modify the characteristics of the 

thematic layers. 

10. Add a new basemap layer to your map. Right-click the data frame name in the table 

of contents and click New Basemap Layer. 

11. This adds a new basemap layer in your table of contents. The basemap layer 

behaves much like a group layer in that you can drag content into it. 

12. Select the layers that will comprise your basemap and drag them into the basemap 

layer. 

13. Click Save as new layer to save the new basemap to the map. 

 
 
RESULT:  
 
The base map is prepared from all the developed map layers from the given Toposheet.  
The basemap layers include:  
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EXPERIMENT – 6 
 

DATA CONVERSION – VECTOR TO RASTER, RASTER TO VECTOR 

 

 AIM: To convert raster map to vector layer and vector layer to raster by using Arc GIS 
Software. 
 
APPARATUS: Arc GIS Software, vector layers or shape files, raster layers or Georeferenced              
and projected Survey of India Toposheet. 
 
THEORY & PRINCIPLE: 
 
DATA CONVERSION: 

Vectorization: Raster to vector conversion  

In GIS digitization refers to creating vector datasets viz., point, line or polygon from raster 

datasets. It is a way of tracing/recording geographic features in vector format from 

georeferenced images or maps. With the help of digitization we can create different set of 

layers Viz. Rivers, roads, schools, ward boundaries and building blocks from a single map; 

this process is known as Vectorization. Vector data is easy to edit, update and is more 

accurate as compared to raster data. Vector data is more efficient for GIS analysis. Due to 

these reasons Vectorization is the first step in many GIS projects.  

 

Vector data is mainly of three types  

- Point: It consists of single points having (X, Y) coordinates, for example lamp posts, bus 

stops and postbox positions etc.  

- Line: It consists a series of (X, Y) coordinates in a sequence (from start node to end node 

with a number of vertices joining these two nodes). For example roads, power lines, 

ward boundaries and contours etc. 

 - Polygon: It is a series of (X, Y) coordinates in a sequence closing a figure where first and 

last points are the same. For example lakes, building blocks, village blocks, ward areas 

and forests etc. 

Rasterization: Vector to Raster conversion 

Rasterisation (or rasterization) is the task of taking an image described in a vector graphics 
format (shapes) and converting it into a raster image (pixels or dots). The rasterised image 
may then be displayed on a video display or printer, or stored in a bitmap file format. 
Rasterisation may refer to either the conversion of models into raster files, or the 
conversion of 2D rendering primitives such as polygons or line segments into a rasterized 
format. 
 
Polygon features to raster data 
When you convert polygons, cells are usually given the value of the polygon found at the 
center of each cell.  
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Polyline feature to raster data 
When you convert polylines, cells are usually given the value of the line that intersects each 
cell. Cells that are not intersected by a line are given the value of No Data. If more than one 
line is found in a cell, the cell is given the value of the first line it encounters when 
processing. Using a smaller cell size during conversion can alleviate this.  
 
Point feature to raster data 
When you convert points, cells are usually given the value of the points found within each 
cell. Cells that do not contain a point are given the value of No Data. If more than one point 
is found in a cell, the cell is given the value of the first point it encounters when processing. 
Using a smaller cell size during conversion may alleviate this.  
 
PROCEDURE: 
 
Raster to vector conversion 
 

1. Open new ArcMap and change the data frame properties to 

WGS_1984_UTM_Zone_44N. 

2. Open the snapping toolbar Via Customize Toolbars>snapping  

3. Make sure snapping is turned on and that all types are active. 

4. Editor -> start editing. Select which layer to edit (your new shapefile point, line or 

polygon). Select the task to perform (Create New Feature). 

5. Select the editing pencil tool and click on, along, or around the features in a 

georeferenced and projected map you want to digitize or vectorize. You can zoom 

and pan to make this easier. 

6. When finished drawing, right click and select Finish Sketch. 

7. To edit the attribute table for the feature you just created click the Attributes icon 

on the Editor Toolbar. 

8. All the editable fields for the feature you just created will appear.  This way you can 

label your features as you create them. 

9. When you’re done creating features click on the Editor button on the Editor toolbar 

and select Save Edits, and then Stop Editing. 

 

Vector to Raster conversion 

1. Open new ArcMap and change the data frame properties to 

WGS_1984_UTM_Zone_44N. 

2. Open vector layers or shape files point, line and polygon 

3. Arc tool box->conversion tools->To Raster->click Feature to Raster. 

4. Give Input feature point/ line/ polygon. 

5. Select the field ID. 

6. Give output raster location to store. 

7. Select output cell size (optional). 

8. Click on ok to finish.  
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RESULT: 

1. Raster to vector conversion: point, line, polygon vector layers 
2. Vector to Raster conversion: point, line, polygon raster layers 
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EXPERIMENT – 7 
 

ADDING ATTRIBUTE DATA – QUERYING ON ATTRIBUTE DATA 

 

AIM: To add attribute data to the shapefile or layer and querying on attribute data 

APPARATUS: Arc GIS Software, vector layers or shape files, Georeferenced and projected 

Survey of India Toposheet. 

 THEORY & PRINCIPLE: 

 

Attribute data: Descriptive information about a set of features and the information needed 

to create the “theme” in a thematic map. It can be a statistical data set collected through 

surveys, Census data, or any other information that describes the features represented in 

your spatial data set. 

 

Adding attribute data  

you can add fields to your table using Arc Catalog or ArcMap. In Arc Catalog, you need to 

open the layer or table's Properties dialog box and add the field to the list on the Fields tab. 

In ArcMap, you can add a field through the attribute table of a layer or through the Catalog 

window by accessing the same Properties dialog box and Fields tab. Inside either 

application you can also use the Add Field geoprocessing tool. 

 

Calculating area, length, and other geometric properties 

To calculate the area or surface, perimeter or length of an entity is required to know the 

geometry of each layer. It is also recommended that each layer has an assigned coordinate 

system. In the following process you can apply to calculate the area and perimeter in a layer 

of polygons. For polyline layers only the length can be calculated, and for 

XY coordinates (for projected coordinates select Double, and for geographic 

coordinates select Text). For example, to calculate the area and perimeter of a polygon, 

right click on the layer select Open Attribute Table. In the attribute table in Table 

Options select Add Field. Assign a name (Area, Perimeter), and in Type select Double and 

accept the changes. It is important to remember that if changes in geometry are caused, the 

area, perimeter, or length fields are not updated automatically. Therefore, the fields must 

be recalculated after having made some geometric change in an entity. 

 

Querying On Attribute Data 

 Selecting records in a table by attributes 

There are various ways to select features in ArcMap. One way is to select features 

through an attribute table. From a table, you can interactively select records by 

pointing at them, or you can select those records that meet some criteria; for 

example, find all cities with a population greater than one million. 

 

https://geogeek.xyz/dictionary/area
https://geogeek.xyz/dictionary/surface
https://geogeek.xyz/dictionary/layer
https://geogeek.xyz/dictionary/coordinate-system
https://geogeek.xyz/dictionary/coordinate-system
https://geogeek.xyz/dictionary/process
https://geogeek.xyz/dictionary/polyline
https://geogeek.xyz/dictionary/coordinates
https://geogeek.xyz/dictionary/projected-coordinates
https://geogeek.xyz/dictionary/select
https://geogeek.xyz/dictionary/geographic-coordinates
https://geogeek.xyz/dictionary/geographic-coordinates
https://geogeek.xyz/dictionary/polygon
https://geogeek.xyz/dictionary/attribute-table
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PROCEDURE: 
 
Adding attribute data: 
 
Adding fields 
 

1. Right-click the table or layer in the table of contents and choose Open Attribute 

Table. 

2. Click the Table Options button  in the table window. 

You can make calculations without being in an editing session; however, in that case, 

there is no way to undo the results. 

3. Click Add Field. 

4. Type the name of the field. 

5. Click the Type arrow and click the field type. 

6. Set any other field properties as necessary. 

7. Click OK. 

Calculating area, length, and other geometric properties 

1. Start an edit session. 

You can make calculations without being in an editing session; however, in that case, 

there is no way to undo the results. 

2. Right-click the layer and click Open Attribute Table. 

You can only perform geometric calculations on attribute tables. 

3. Right-click the field heading for which you want to make a calculation and 

click Calculate Geometry. 

Optionally, you can press CTRL+SHIFT+G to open the Calculate Geometry dialog box. 

4. Click the geometric property (area, perimeter, length etc)you want to calculate. 

Different properties are available depending on the type of layer you're using. 

5. Click to use either the coordinate system of the data source or the coordinate 

system of the data frame. 

6. Click the units of the output calculations. 

7. Optionally, if you have selected records in the table, choose whether to apply the 

calculations to all records or just the selected ones. 

8. Click OK. 

 

http://desktop.arcgis.com/en/arcmap/10.3/manage-data/editing-fundamentals/starting-an-edit-session.htm
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Querying On Attribute Data: 

Selecting records in a table by attributes: 
 

1. Click to open layer attribute data, click on Table Options  in the table you want to 

query and click Select By Attributes . 

2. Click the Method arrow and click the selection procedure you want to use. 

3. Double-click the field from which you want to select. 

4. Click the logical operator you want to use. 

5. Click the Get Unique Values button, then scroll to and double-click the value you 

want from the Unique Values list. 

Optionally, you can type a value directly into the text box. 

6. Click Verify to verify your selection. 

7. Click Apply to update the selection. 

8. Click Close. 

Note:  

Write a query in the query builder 

e.g. 

1. "height">= 550 
2. "water body" = 'Osman sagar' 

 
RESULT: 

1. New attribute data field is added to the shapefile layer and calculated its geometry 

2. Selected records in a table by using Querying On Attribute Data 
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EXPERIMENT – 8 

VECTOR ANALYSIS 

AIM: To perform Vector Analysis using Geoprocessing Tools using ArcGIS 

 

APPARATUS: Arc GIS Software, vector layers or shape files, Georeferenced and projected 

Survey of India Toposheet. 

 

 THEORY & PRINCIPLE: 

 
Vector Analysis 

• Vector analysis includes any of the formal techniques which study entities using 
their topological, geometric, or geographic properties. Spatial analysis has a set of 
tools used for analyzing spatial data. The results of spatial analysis are depended on 
the location of the objects being analyzed. 

Geoprocessing tools 

Geoprocessing is a framework and set of tools for processing geographic and related data. 
The large suite of geoprocessing tools can be used to perform spatial analysis or manage GIS 
data in an automated way. Geoprocessing tools allow you to create, conduct surface 
analysis on, modify, and convert terrain datasets. 

Buffer: 

The Buffer tool creates a new coverage of buffer polygons around specified input coverage 
features. Features can be polygons, lines, points, or nodes. You can use the Buffer tool to 
identify or define an area within a specified distance around a feature. For example, you 
may create a buffer to define an area around a river to identify land that can't be 
developed, or you may want to create a buffer to select features within a specified distance 
of a feature. 
 

Clip: 

Extracts input features that overlay the clip features. Use this tool to cut out a piece of one 
feature class using one or more of the features in another feature class as a cookie cutter. 
This is particularly useful for creating a new feature class—also referred to as study area or 
area of interest (AOI)—that contains a geographic subset of the features in another, larger 
feature class. 

 The Clip Features can be points, lines, and polygons, depending on the Input 
Features type.  

o When the Input Features are polygons, the Clip Features must also be 
polygons.  

o When the Input Features are lines, the Clip Features can be lines or polygons. 
When clipping line features with line features, only the coincident lines or 
line segments are written to the output, as shown in the graphic below.  

https://en.wikipedia.org/wiki/Scientific_technique
https://en.wikipedia.org/wiki/Topological
https://en.wikipedia.org/wiki/Geometric
https://en.wikipedia.org/wiki/Geographic
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o When the Input Features are points, the Clip Features can be points, lines, or 
polygons. When clipping point features with point features, only the 
coincident points are written to the output, as shown in the graphic below. 
When clipping point features with line features, only the points that are 
coincident with the line features are written to the output. 

 The Output Feature Class will contain all the attributes of the Input Features. 

Intersect: 

Intersect creates a new feature from the common areas or edges of any two selected 
features of the same geometry type. The new intersected feature is created using the 
settings specified in the chosen feature template.You can create a new feature from the 
intersection of features of different layers, but the layers must be of the same geometry 
type (either line or polygon). The original features are maintained, and the new feature is 
created without attribute values in the current layer. You must manually enter attribute 
values for the new feature. 

Union:  

Union combines selected features into one new feature. Although the features may be from 
different layers, the layers must be of the same geometry type—either line or polygon. 
Union calculates the geometric union of any number of feature classes and feature layers.All 
input feature classes or feature layers must be polygons.  The output feature class will 
contain polygons representing the geometric union of all the inputs as well as all the fields 
from all the input feature classes. See below for examples of how attribute values are 
assigned to the output features. 

Union does the following: 

 Determines the spatial reference for processing. This will also be the output spatial 
reference. For details on how this is done, see Spatial Reference. All the input 
feature classes are projected (on the fly) into this spatial reference.  

 Cracks and clusters the features. Cracking inserts vertices at the intersection of 
feature edges; clustering snaps together vertices that are within the x,y tolerance.  

 Discovers geometric relationships (overlap) between features from all feature 
classes.  

 Writes the new features to the output.  

Merge: 

Combines multiple input datasets of the same data type into a single, new output dataset. 
This tool can combine point, line, or polygon feature classes or tables. 

Usage: 

 All fields in the output dataset and the contents of those fields can be controlled 
using the Field Map controls. 

mk:@MSITStore:C:/PROGRA~2/ArcGIS/DESKTO~1.1/Help/ANALYS~1.CHM::/00080000000s000000.htm
mk:@MSITStore:C:/PROGRA~2/ArcGIS/DESKTO~1.1/Help/ANALYS~1.CHM::/00080000000s000000.htm
javascript:IDAJDVEB.Click()
javascript:IDALUWHB.Click()
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 If feature classes are being merged, the output dataset will be in the coordinate 
system of the first feature class in the Input Datasets list, unless the Output 
Coordinate System geoprocessing environment is set. 

 This tool does not support annotation feature classes. Use the 
Append_Annotation_Feature_Classes tool to combine annotation feature classes. 

 This tool does not support raster datasets. Use the Mosaic To New Raster tool to 
merge multiple rasters into a new output raster. 

Dissolve: 

Creates a new coverage by merging adjacent polygons, lines, or regions that have the same 
value for a specified item. 

Usage: 

 This tool is used to create a simplified coverage from one that is more complex. 
Although the input coverage may contain information concerning many feature 
attributes, the output coverage contains information only about the dissolve item. 

 The merging of polygons with this tool is the counterpart of intersecting polygons in 
overlays. Dissolve will remove the boundaries. 

 Dissolve eliminates nodes or arcs between adjacent lines or polygons containing 
equal values for the dissolve item. 

PROCEDURE: 
 

Buffer: 

1. Click the Geoprocessing tools and click Buffer. 

2. Input the feature around which you want to create a buffer.  

3. Type the distance in map units for the buffer area around the feature.  

4. Choose the target in which the new feature will be created.  

o If you have feature templates for the layers in your map, click the Template 

button and click the template to use to create the new feature. You can also 

double-click the preview of the template to choose a different template.  

o If you do not have feature templates, click the layer in which to create the 

feature.  

5. Click OK.  

Clip: 

1. Click the Geoprocessing tools and click Clip. 

2. Select or input the features you want to use to clip.  
3. Type a buffer value. You can leave the value as 0 if you are clipping with a polygon 

feature.  
4. Click the type of clip operation: whether to discard or maintain the area that 

intersections.  

javascript:IDABWWHB.Click()
javascript:IDABWWHB.Click()
mk:@MSITStore:C:/PROGRA~2/ArcGIS/DESKTO~1.1/Help/DATA_M~1.CHM::/001700000029000000.htm
mk:@MSITStore:C:/PROGRA~2/ArcGIS/DESKTO~1.1/Help/DATA_M~1.CHM::/001700000098000000.htm
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5. Click OK to clip the feature. 

Intersect: 

1. Click the Geoprocessing tools and click Intersect 

2. Select or input the features from whose intersection you want to create a new 
feature.  

3. Choose the target folder in which the new feature will be created.  
o If you have feature templates for the layers in your 3D view, click the 

Template button and click the template in which to create the new feature. 
You can also double-click the preview of the template to choose a different 
template.  

o If you do not have feature templates, click the layer in which to create the 
new feature.  

4. Click OK.  

Union:  

1. Click the Geoprocessing tools and click Union  

2. Select or input the features you want to combine into one  

3. Choose the target folder in which the new feature will be created.  

4. If you have feature templates for the layers in your map, click the Template 

button and click the template to use to create the new feature. You can also 

double-click the preview of the template to choose a different template.  

5. If you do not have feature templates, click the layer in which to create the 

feature.  

6. Click OK.  

Merge: 

1. Click the Geoprocessing tools and click Merge 

2. Select or input the features you want to merge. The features must be from 

the same layer.  

3. Choose the target folder in which the new feature will be created.  

4. Click the feature that the features will be merged into and will supply the 

attributes for the merged feature.  

5. Click OK.  

Dissolve: 

1. Click the Geoprocessing tools and click Dissolve 

2. Select or input the features you want to Dissolve 

3. Select the output feature class 

4. Select the dissolve field (optional) 

5. Choose the target folder in which the new feature will be created 

mk:@MSITStore:C:/PROGRA~2/ArcGIS/DESKTO~1.1/Help/ANALYS~1.CHM::/00080000000s000000.htm
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6. Click OK.  

RESULTS: 

Vector Analysis is performed using Geoprocessing Tools in ArcGIS  

The resultant layers generated are: 

Buffer: point buffer, line buffer, polygon buffer 

Clip: Clip feature 

Intersect: Intersected polygons  

Union: polygons combine into one  

Merge: polygons merged 

Dissolve: Dissolved features  
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EXPERIMENT – 9 

RASTER ANALYSIS 

AIM: To perform Raster Analysis using ArcGIS 
 
APPARATUS: Arc GIS Software, vector layers or shape files, Georeferenced and projected 

Survey of India Toposheet. 
 
THEORY & PRINCIPLE: 
 
Raster analysis  

Raster analysis is similar in many ways to vector analysis. Raster analysis, on the other 

hand, enforces its spatial relationships solely on the location of the cell. Raster operations 

performed on multiple input raster datasets generally output cell values that are the result 

of computations on a cell-by-cell basis. The value of the output for one cell is usually 

independent of the value or location of other input or output cells. In some cases, output 

cell values are influenced by neighboring cells or groups of cells, such as in focal functions. 

Types of Raster Analysis: 

• Math  

• Distance  

• Surface analysis 

• Extraction or clip 

• Change cell values  

• Statistical Analysis  

• Conditional  

• Weighted overlay  

• Vector to Raster Transformations 

PROCEDURE: 
 
Raster Clip: 
 

1. Arc Toolbox > Data Management > Raster > Raster Processing > Clip 
2. Double-Click The Clip Tool To Open 
3. Input Raster 
4. Give the Output Extent (Optional) 
5. Use Input Feature For Clipping Geometry 
6. Output Raster Dataset: This Is The Name Of The Output (Clipped Raster). Add an 

Extension for the Output Such As .Tif, .Img, or .Jpg. 
 
Mosaic Raster:  
 

1. Arc Toolbox > Data Management > Raster > Raster Dataset 

2. Click the Mosaic to New Raster Tool To Open 

3. Input raster datasets to mosaic 

4. Give the output location to store 
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5. Raster Dataset Name with Extension Such As .Tiff, .Img, or .Jpg. 

6. Select spatial reference for the raster (optional) 

7. Select pixel type 

8. Select cell size (optional) 

9. Give the number of bands that the output raster will have. 

10. Click on ok. 

Vector to Raster conversion 

1. Open new ArcMap and change the data frame properties to 

WGS_1984_UTM_Zone_44N. 

2. Open vector layers or shape files point, line and polygon 

3. Arc tool box->conversion tools->To Raster->click Feature to Raster. 

4. Give Input feature point/ line/ polygon. 

5. Select the field ID. 

6. Give output raster location to store. 

7. Select output cell size (optional). 

8. Click on ok to finish.  

 
 
RESULTS: 
 

Raster Analysis is performed using Raster Processing, Raster Dataset, conversion 

tools in ArcGIS  

The resultant layers generated are: 

1. Raster Clip 
2. Mosaic Raster 
3. Vector to Raster conversion: point, line, polygon 
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EXPERIMENT – 10 

MAP COMPOSITION 
 

AIM: To compose the map by adding map components, layout and Exporting Map 

APPARATUS: Arc GIS Software, vector layers or shape files, Raster layers or Georeferenced 
and projected Survey of India Toposheet. 

 
THEORY & PRINCIPLE: 
 
Map Composition  
 
Map Composition is the process of bringing together the various symbols on a map so that 
they work together to form a desired Gestalt, or whole effect. The term is generally applied 
to the combination of layers of geographic symbols in the map image itself; the inclusion of 
additional elements such as titles, legends, and scale bars are referred to as Map layout. 
Quality composition is crucial to creating a map that is both functionally effective 
and aesthetically pleasing. Most of the principles and techniques of composition are based 
on the concept of Gestalt, in which that all of the elements of an artistic work (for example, 
a map) are perceived by viewers as a whole, so that viewers will develop a general 
judgment of the map, whether positive or negative. 

 
Map Layout 
 
Map Layouts in ArcGIS allow users to quickly create maps of spatial data, and to include 
charts, tables, north arrows, scale bars, text and graphical primitives, and graphics files. 
 
Map Layout elements:  
 
Data frame:  
A data frame's name property is always the same as what's shown in the table of contents. 
Therefore, updating the name inside the Data Frame Properties dialog box will also update 
its name in the table of contents. 
 
North arrow: 
 
North arrows indicate the orientation of the map. A north arrow element maintains a 
connection to a data frame. When that data frame is rotated, the north arrow element will 
rotate with it. North arrow properties include its style, size, color, and angle. 
 
Legend: 
 
A legend tells a map reader the meaning of the symbols used to represent features on the 
map. Legends consist of examples of the symbols on the map with labels containing 
explanatory text. When you use a single symbol for the features in a layer, the layer is 
labeled with the layer's name in the legend. When you use multiple symbols to represent 
features in a single layer, the field you use to classify the features becomes a heading in the 
legend, and each category is labeled with its value. 

http://wiki.gis.com/wiki/index.php/Gestalt
http://wiki.gis.com/wiki/index.php/Map_layout
http://wiki.gis.com/wiki/index.php/Aesthetics
http://wiki.gis.com/wiki/index.php/Gestalt
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Scale bar:  

Scale bars provide a visual indication of the size of features and distance between features 
on the map. A scale bar is a line or bar divided into parts and labeled with its ground length, 
usually in multiples of map units such as tens of kilometers or hundreds of miles. If the map 
is enlarged or reduced, the scale bar remains correct. 

Scale text: 

You can also represent the scale of your map with scale text. Scale text indicates the scale of 
the map and features on the map. Scale text tells a map reader how many ground units are 
represented by a map unit—for example, 1 centimeter equals 100,000 meters. 

Export a map or layout 

After you've created a map or layout, you may want to share it as a file. You can export to 
several industry-standard file formats. 

 EMF, EPS, PDF, SVG, and SVGZ formats are referred to as vector export formats, 
because they support a mixture of vector and raster data. 

 BMP, JPG, PNG, TIFF, TGA, and GIF are referred to as image export formats, because 
they are purely raster export formats. 

PROCEDURE: 
 
Map composition steps: 

 

1. Starting ArcGIS 

2. Getting Data into GIS 

3. Preparing the Data 

4. Adding Data to ArcMap 

5. Organizing Layers 

6. Editing the Airport Layer 

7. Switching to Layout View 

8. Adding and Editing Map Information 

9. Finalizing the Map 

10. Saving the Map as an Image 

 
Creation of Map Layout: 

 Click on layout view and Creating a new page layout 

 Add data frame to the page layout 

 Add  map elements to the page layout 

 Working with map elements 

 Working with a page layout 

http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_3341CBCABDDC4312A98A7C749EBCE5BF
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_10B4C9CEB30C4FE6835A36795EAD2F9A
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_18038C3C34F04CFA990BB649FB72FC59
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_15D9DC291608405D900744EF68FD3190
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_24D8C0653C1744DAAA881D229E14A327


32 

 

Department of Civil Engineering             Geographical Information Systems Laboratory Manual 

 Data Driven Pages 

 Grids and Graticules 

 Printing and exporting your layout 

 Creating a map layout 

Exporting Map: 

1. Arc map click on file  

2. Click on export map command to export map layout  

3. Select EMF, EPS, PDF, SVG, and SVGZ for vector data export  

4. Select BMP, JPG, PNG, TIFF, TGA, and GIF for raster data export 

5. Click ok to Export and Save the Map  

 

RESULTS: Map is composed by adding map components, layout and Map is Exported. 

Eg: Base Map composition 

http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_E04003647DD24C96BB0088C9DC034D66
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_9853C59ED7044456A7360F071B7BEC79
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#ESRI_SECTION1_7EB940E9070B4183A4DA07FFF9BBCB6C
http://desktop.arcgis.com/en/arcmap/10.3/map/page-layouts/a-quick-tour-of-page-layouts.htm#GUID-01FF484E-1DC0-470E-BC85-E9BCDE675E73

